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Dotychczas w  EP na temat CCS
EP9/2011 „Code Composer Studio v4 – 
zintegrowane środowisko projektowe”
EP10/2011 „Code Composer Studio v4 – praca 
z  projektem”

Dodatkowe informacje:
Strona produktu http://www.ti.com/ccs 
Bazowa strona dokumentacji 
http://processors.wiki.ti.com/index.php/CCSv4
Pomoc środowiska CCSv4 z  menu Help → 
Help  Contents.

Dodatkowe materiały na CD/FTP:
ftp://ep.com.pl, user: 15352, pass: 760hp6s5

•	poprzednie części artykułu

Debugowanie projektu wymaga zdefinio-
wania konfiguracji sprzętowej systemu docelo-
wego (target configuration setting). Konfiguracja 
systemu docelowego jest wpisywana do pliku 
w formacie XML o rozszerzeniu „ccxml”. Plik 
może być kopiowany, usuwany i  otwierany. 
Konfiguracja określa niezależnie dwa elementy:

•	 Połączenie (connection) – typ emulatora 
lub symulatora.

•	 Docelowy układ/płytka – typ układu scalo-
nego (układu procesorowego) lub struktura 
płytki drukowanej.
Interfejs graficzny do definiowania konfi-

gurowania systemu docelowego jest obecnie 
częścią środowiska CCSv4. Użytkownik może 
sam określić kombinację emulatora i  układu 
procesorowego.

Plik konfiguracji systemu docelowego dla 
projektu może być:

•	 Wpisany (dodany) do foldera projektu.
•	 Dołączony (bez przepisywania) do projektu 

z lokalizacji domyślnej.

Tworzenie nowej konfiguracji 
sprzętowego systemu docelowego

Rozpoczęcie tworzenia nowej konfiguracji 
systemu docelowego można wykonać na kilka 
sposobów:

•	 Wybór z menu opcji Target → New Target 
Configuration. 

•	 Wybór z menu opcji File → Target → New 
Target Configuration. 

•	 Kliknięcie prawym klawiszem myszy na linię 
projektu w  oknie C/C++ Projects. Z  menu 
kontekstowego należy wybrać pozycję New, 
a następnie Target Configuration File.

Code Composer Studio v4 (3)
Debugowanie projektu

Debugowanie projektu w  środowisku CCSv4 jest wykonywane przez 
program debuggera będący elementem środowiska. Debugger pracuje 

na komputerze PC i  łączy się z  układem sprzętowym nazywanym 
emulatorem sprzętowym. Połączenie typowo wykorzystuje łącze 

USB. Emulator jest dołączony do łącza JTAG docelowego układu 
scalonego (układu procesorowego). 

Otwierane jest wtedy okno edycyjne New 
Target Configuration (rysunek  1). W  polu File 
Name należy wpisać nazwę dla pliku konfi-
guracji systemu docelowego z  rozszerzeniem 
„ccxml”. Najlepiej użyć nazwy dobrze opisują-
cej zastosowany układ sprzętowy. 

W  polu Location należy podać miejsce 
umieszczenia pliku. Można wskazać dwa różne 
miejsca umieszczenia pliku konfiguracji:

•	 Lokalizacja pliku konfiguracji we wspól-
nym (domyślnym) folderze – z  wybraną 
opcją Use shared location.

•	 Lokalizacja pliku konfiguracji w  folderze 
projektu – przy wyłączeniu opcji Use sha-
red location. Plik będzie dodany do projek-
tu.
Plik konfiguracji systemu docelowego musi 

być określony dla każdego indywidualnego pro-
jektu środowiska CCSv4. 

Lokalizacja pliku 
konfiguracji w folderze 
projektu

W  oknie New Target Configura-
tion należy wyłączyć (odznaczyć) 
opcję Use shared location (rysu-
nek 1). Następnie należy kliknąć na 
przycisk Browse. W  otworzonym 
oknie pokazywany jest folder, w któ-
rym umieszczony jest projekt. Wy-
starczy kliknąć na przycisk OK. 

W  oknie New Target Configura-
tion wybrana jest ścieżka bieżącego 
projektu (rys. 1). Wszystkie elementy potrzebne 
do pracy z projektem znajdują się wtedy w tym 
samym folderze. Po wcześniejszym wpisaniu 
odpowiedniej nazwy pliku *.ccxml w  oknie 
New Target Configuration i  ustawieniu ścieżki 
należy kliknąć na przycisk Finish. 

Wybór typu emulatora sprzętowego 
i układu procesorowego

Otwierane jest okno edycyjne zatytułowane 
tak jak nazwa utworzonego pliku konfiguracji 
systemu docelowego (rysunek 2). 

Okno jest zorganizowane jako trzy zakład-
ki. Na zakładce Basic w panelu General Setup 

należy wybrać odpowiednie opcje. Najpierw 
na liście rozwijanej pola Connection trzeba 
wybrać typ emulatora, np. Texas Instruments 
XDS100v1 USB Emulator (rysunek 3). Następ-
nie należy poczekać do chwili, gdy w  oknie 
Device zostanie wyświetlona lista układów pro-
cesorowych i płytek uruchomieniowych (rysu-
nek 4). Teraz trzeba suwakiem przewinąć listę 
w  oknie Device. Właściwie jest to lista sprzę-
towych systemów docelowych, więc jeden typ 
układu procesorowego może występować wie-
lokrotnie, np. samodzielnie lub jako element 
płytki eZdsp. Po znalezieniu nazwy odpowied-

Rysunek 1. Wybór nazwy i foldera dla 
pliku konfiguracji systemu docelowego

Rysunek 2. Okno edycyjne pliku konfiguracji sys-
temu docelowego środowiska CCSv4 (ustawienia 
domyślne)

Rysunek 3. Wybór emulatora sprzęto-
wego w oknie edycyjnym konfiguracji 
systemu docelowego środowiska CCSv4

KURS
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budowania inkrementacyjnego aktywnego pro-
jektu, uruchomienie debugera, automatyczne 
dołączenie debugera do docelowego układu 
procesorowego (systemu), załadowanie kodu 
wynikowego (programu) do układu procesoro-
wego i otworzenie (przełączenie) perspektywy 
Debug.

Środowisko CCSv4 również wspiera uru-
chamianie programów z zastosowaniem symu-
latora oraz systemu operacyjnego czasu rzeczy-
wistego DSP/BIOS.

Perspektywa Debug
Standardowa perspektywa Debug środo-

wiska CCSv4 jest automatycznie otwierana po 
uruchomieniu debuggera (rysunek  6). Po do-
łączeniu debugera do układu procesorowego 
oraz po załadowaniu do układu procesorowe-
go kodu programu typowo otwierane jest okno 
Debug, okna danych Local i Watch oraz okno 
edytora z kodem źródłowym pliku zawierające-
go funkcję main(). Przy uruchamianiu projektu 
kolejny raz mogą być również otwierane inne 
okna, np. Disassembly.

Po lewej stronie okna edycyjnego jest pa-
sek wyboru (Selection Margin). Na pasku wy-
boru pokazywana jest kolorowa strzałka, gdy 
załadowany jest plik wynikowy programu do 

Jeden plik może być wybrany jako Active/De-
fault. Konfiguracja systemu docelowego ozna-
czona jako domyślna jest używana po wyda-
niu polecenia Target → Launch TI Debugger.

Uruchomienie debuggera
Wykonanie w  perspektywie C/C++ pole-

cenia z menu Target → Lunch TI Debugger po-
woduje uruchomienie debuggera i otworzenie 
perspektywy Debug. Można teraz ręcznie do-
łączyć układ procesorowy (system docelowy) 
poleceniem Connect Target. Można również 

ręcznie załadować (zapro-
gramować) kod do pamięci 
układu procesorowego.

Zestawienie poleceń 
rozpoczęcia/zakończenia 
(sesji) debugowania jest 
zamieszczone w  tabeli  1. 
Wykonanie w  perspekty-
wie C/C++ polecenia De-
bug Active Project (menu 
Target → Debug Active 
Project) lub przyciśnięcie 
przycisku Debug powo-
duje automatyczne rozpo-
częcie sesji debugowania. 
Powoduje to wykonanie 

niego układu procesorowego należy kliknąć 
(zaznaczyć) na jeden (tylko) kwadracik na lewo 
od wybranego elementu. Następnie należy od-
czekać, aż linia zostanie zaznaczona na ciemno 
(rysunek 5).

Na zakładce Advanced można zobaczyć 
(i  zmienić) szczegółowe ustawienia konfigu-
racji. Zakładka Source umożliwia oglądanie 
(i  edycję) wygenerowanego pliku XML. Na 
koniec należy na zakładce Basic kliknąć na 
przycisk Save. Należy poczekać na zakończe-
nie zapisywania. Wtedy przycisk zostanie wy-
świetlony w szarym kolorze.

Tylko jeden plik konfiguracji systemu do-
celowego związany z projektem może zostać 
ustawiony (i  oznaczony) jako aktywny (Acti-
ve). Dodany nowy plik konfiguracji systemu 
docelowego jest automatycznie ustawiany 
jako aktywny. Można zmieniać wybór pliku 
aktywnego w  oknie C/C++ Project. Należy 
kliknąć na nazwę pliku konfiguracyjnego pra-
wym klawiszem myszy i  wybrać opcję Set 
as Active Target Configuration. Konfiguracja 
systemu docelowego aktywna jest używana 
domyślnie po wydaniu polecenia Target → De-
bugg Active Project.

Tylko jeden plik konfiguracji systemu do-
celowego związany z projektem może zostać 
ustawiony jako domyślny (Default). Można 
zmieniać wybór pliku domyślnego w  tym 
oknie. Należy kliknąć na nazwę pliku konfi-
guracyjnego prawym klawiszem myszy i wy-
brać opcję Set as Active Default Configuration. 

Rysunek 4. Lista sprzętowych systemów 
docelowych w oknie edycyjnym konfi-
guracji systemu docelowego środowiska 
CCSv4

Rysunek 5. Okno edycyjne pliku konfiguracji systemu doce-
lowego środowiska CCSv4 po wybraniu emulatora sprzęto-
wego i typu układu procesorowego

Rysunek 6. Okno perspektywy Debug środowiska CCSv4 po wykonaniu w perspektywie 
C/C++ polecenia Debug Active Project (budowanie projektu, uruchomienie debuggera, 
załadowanie kodu)

Tabela 1  Polecenia (najważniejsze) rozpoczęcia/zakończenia (sesji) debugowania
Ikona Nazwa Opis Umiejscowienie

New Target 
Configuration

Tworzenie nowego pliku konfiguracji 
sprzętowej systemu docelowego

File New Menu
Target Menu

Debug Active 
Project

Uruchomienie sesji debugowej z  użyciem 
aktywnego (active) projektu

Debug Toolbar
Target Menu

Launch TI De-
bugger

Uruchomienie debuggera z  użyciem 
domyślnej (target) konfiguracji systemu 
docelowego

Debug Toolbar
Target Menu

Debug
Uruchomienie sesji debugowej z  użyciem 
bieżącej konfiguracji. Przycisk ze strzałką 
otwiera listę wyboru

Debug Toolbar
Target Menu

Connect Target Dołączenie debuggera do układu proce-
sorowego

TI Debug Toolbar
Target Menu
Debug View Context Menu

Terminate All Zamyka wszystkie sesje debugowe Target Menu
Debug View Toolbar
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pamięci układu procesorowego i  wykonywa-
nie programu jest zatrzymane w obrębie kodu 
pokazywanego w  oknie. Jest ona powiązana 
z zawartością licznika rozkazów PC. Wskazuje 
na linię kodu języka C związanego z instrukcją 
(asemblerową) spod adresu w PC.

Dołączanie/odłączanie sprzętu do 
CCSv4

CCSv4 umożliwia dynamiczne dołączanie 
i odłączanie docelowego układu procesorowe-
go (systemu). Na początku pracy CCSv4 jest do-
myślnie odłączony od układu procesorowego. 
Pozwala to na pracę środowiska bez fizycznej 
obecności układu procesorowego. Uruchomie-
nie debuggera środowiska CCSv4 (np. z menu 
Target → Lunch TI Debugger) nie powoduje au-
tomatycznego dołączenia do docelowego ukła-
du procesorowego.

Dołączenie CCSv4 do docelowego układu 
procesorowego jest możliwe po wcześniejszym 
zdefiniowaniu konfiguracji docelowego syste-
mu sprzętowego. Oznacza to określenie typu 
emulatora sprzętowego dołączonego do kom-
putera PC oraz typu układu procesorowego 
docelowego dołączonego do emulatora poprzez 
łącze JTAG.

Dołączenie do docelowego układu pro-
cesorowego jest wykonywane po kliknięciu 
na przycisk Connect Target na pasku narzędzi 
perspektywy Debug. Ponowne kliknięcie przy-
cisku, nazywanego obecnie Disconnect Target, 
powoduje odłączenie od docelowego układu 
procesorowego.

Po poprawnym wykonaniu polecenia Con-
nect środowisko CCSv4 komunikuje się z pro-
cesorem docelowym. Automatycznie otwierane 
jest okno Debug oraz okno deasemblacji Disas-
sembly.

Okno Debug
Okno Debug jest dostępne w perspektywie 

Debug środowiska CCSv4 (rysunek 7). W oknie 
jest pokazywany stan stosu dla aktualnie de-
bugowanego układu procesorowego. Są one 
omówione w  tabeli 2. Po zatrzymaniu działa-
nia programu jest pokazywana w perspektywie 
Debug zawartość okien dla ramki umieszczonej 
na szczycie stosu. Można także oglądać stan dla 
innych ramek stosu. Dla procesorów wielordze-
niowych, jak TMS320F28035 Piccolo, w oknie 
Debug pokazywany jest stan obu rdzeni (rys. 7). 
Na pasku narzędzi okna Debug są dostępne pod-
stawowe przyciski wykonywania programu.

Tabela 2  Polecenia (najważniejsze) ładowania programu/symboli
Ikona Nazwa Opis Umiejscowienie

Load Program
Ładowanie kodu wynikowego budowania 
projektu z  pliku typu COFF (*.out) do układu 
procesorowego (lub symulatora)

Target Menu
Debug Toolbar
Modules View Toolbar

Load Symbols

Ładowanie symboli dla pliku wynikowego 
umieszczonego w  pamięci nieulotnej typu Flash 
lub ROM. Powoduje wyczyszczenie tablicy sym-
boli i  załadowanie nowej zawartości

Target Menu
Modules View Toolbar

Reload Program
Ponowne załadowanie kodu wynikowego bu-
dowania projektu z  pliku typu COFF (*.out) do 
układu procesorowego (lub symulatora)

Target Menu
Debug Toolbar
Modules View Toolbar

Tabela 3.  Polecenia (najważniejsze) wykonania programu
Ikona Nazwa Opis Umiejscowienie

Halt

Zatrzymanie wykonywania programu przez 
układ procesorowy. Okna perspektywy Debug 
są automatycznie odświeżane przy zastosowaniu 
pobranych nowych danych. 

Target Menu
Debug View Toolbar

Run

Wznowienie wykonanie programu, który jest 
aktualnie załadowany do pamięci układu proce-
sorowego od bieżącego stanu licznika rozkazów 
PC. Wykonywanie programu jest kontynuowane, 
aż do napotkania pułapki

Target Menu
Debug View Toolbar

Run to Line

Wznowienie wykonanie programu, który jest 
aktualnie załadowany do pamięci układu proce-
sorowego od bieżącego stanu licznika rozkazów 
PC. Wykonywanie programu jest kontynuowane 
aż do osiągnięcia wskazanej linii kodu źródło-
wego/asemblerowego

Target Menu
Disassembly Context 
Menu
Source Editor Context 
Menu

Go to Main Uruchamia program do początku funkcji main(). Debug View Toolbar

Step Into
Praca krokowa poziomu kodu źródłowego C/
C++ z  wchodzeniem do zaznaczonej instrukcji 
(funkcji) i  zatrzymaniem wykonania

Target Menu
Debug View Toolbar

Step Over

Praca krokowa poziomu kodu źródłowego C/
C++ z  wykonaniem zaznaczonej instrukcji 
(funkcji) i  zatrzymaniem wykonania na pierwszej 
instrukcji po powrocie na ten sam poziom

Target Menu
Debug View Toolbar

Step Return
Wykonanie bieżącej funkcji do końca i  zatrzy-
manie wykonania na pierwszej instrukcji po 
powrocie na wyższy poziom

Target Menu
Debug View Toolbar

Reset
Przerwanie wykonywania bieżącego programu 
i  wymuszenie operacji RESET układu procesoro-
wego

Target Menu
Debug View Toolbar

Restart

Ustawia licznik rozkazów PC na wartość punktu 
wejścia programu aktualnie załadowanego do 
pamięci układu procesorowego. Następnie pro-
gram jest wykonywany do określonego miejsca, 
typowo do początku funkcji main()

Target Menu
Debug View Toolbar

Assembly Step 
Into

Praca krokowa poziomu kodu asemblerowego 
z  wchodzeniem do zaznaczonej instrukcji (funk-
cji) i  zatrzymaniem wykonania

TI Explicit Stepping 
Toolbar
Target Advanced 
Menu

Assembly Step 
Over

Praca krokowa poziomu kodu źródłowego C/
C++ z  wykonaniem zaznaczonej instrukcji 
(funkcji) i  zatrzymaniem wykonania na pierwszej 
instrukcji po powrocie na ten sam poziom

TI Explicit Stepping 
Toolbar
Target Advanced 
Menu

Rysunek 7. Okno Debug perspektywy 
Debug w środowisku CCSv4 po załado-
waniu kodu

Okno Disassembly
W  oknie deasemblacji (Disassembly) jest 

pokazywany kod asemblerowy (i maszynowy) 
programu znajdującego się w  pamięci układu 
procesorowego po wykonaniu deasemblacji 
(rys. 6). Okno deasemblacji może być pokazy-
wane w obu perspektywach C/C++ oraz Debug. 
W tym oknie pokazywane są informacje symbo-
liczne dla adresów funkcji i zmiennych języka 
C (o ile są dostępne). W oknie można przejść do 
dowolnego poprawnego adresu. Deasemblacja 
zawartości pamięci programu (kodu źródło-
wego) wykonywana jest dynamicznie podczas 

zmiany adresu w oknie. Na pasku tytułu okna 
pokazywany jest najbliższy symbol adresowy 
i  przesuniecie względem niego pierwszej linii 
pokazywanej w oknie. 

Okno deasemblacji można otworzyć 
z menu View → Disassembly. Podczas wykony-
wania programu w  pracy krokowej zawartość 
okna deasemblacji jest dynamicznie aktualizo-
wana.

Po poprawnym wykonaniu polecenia Con-
nect środowisko CCSv4 komunikuje się z proce-
sorem docelowym. Automatycznie otwierane 
jest okno deasemblacji (rys. 6). Pokazywana jest 
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boli adresowych i są one używane do debugo-
wania. Nie jest wymagane ponowne progra-
mowanie pamięci Flash. W celu załadowania 
danych symbolicznych należy z menu wybrać 
Target → Load Symbols. Otwierane jest wtedy 
typowe okno dialogowe (rys. 8), w którym na-
leży wybrać plik wynikowy *.out (typowo np. 
w  folderze Debug). Po wykonaniu tej operacji 
debugger środowiska CCSv4 uwzględnia infor-
mację symboliczną tak jak po zaprogramowa-
niu pamięci Flash układu procesorowego. 

Uruchamianie programu, praca 
krokowa i polecenie Reset

U k ł a d y   p r o c e s o r o w e   r o d z i n y 
TMS320C2000 mają bardzo rozbudowany 
sprzętowy układ wspomagania procesu uru-
chamia kodu. Środowisko CCSv4 umożliwia 
przeprowadzenie uruchamiania programu na 
różne sposoby. Do uruchamiania programu słu-
ży perspektywa Debug. Udostępnia ona wiele 
poleceń przy użyciu: ikonek na pasku narzędzi 
perspektywy Debug, ikonek na pasku narzędzi 
okna Debug, poleceń w  menu kontekstowym 
okna Debug lub poleceń z menu File oraz Tar-
get. Można podzielić polecenia na:

•	 polecenia rozpoczęcia/zakończenia sesji 
debugowania,

•	 polecenia ładowania programu/symboli,
•	 polecenia wykonania programu.

Uruchamianie programu
Jest kilka poleceń w perspektywie Debug, 

które dotyczą wykonywania programu (tab. 3):
•	 Target → Reset → Reset  CPU – Polecenie 

powoduje przerwanie wykonywania bie-
żącego programu i  wymuszenie operacji 
RESET układu procesorowego. Polecenie 
jest dostępne po dołączeniu debuggera do 
układu procesorowego. Jest to wykonywa-
ne poprzez łącze JTAG i nie do końca jest 
realizowane tak samo jak RESET sprzęto-
wy. Nie są np. zmieniane ustawienia mo-
dułu PLL. Typowo układ procesorowy jest 
następnie zatrzymywany na pierwszej in-
strukcji programu BOOT-loadera .

•	 Target → Reset → Reset Emulator – Polece-
nie jest dostępne po dołączeniu emulatora 
do komputera bez konieczności dołączania 
debuggera do układu procesorowego. 

•	 Target → Restart – Polecenie typowo jest 
używane po poleceniu Reset CPU. Jego 
działanie jest określone w opcji Auto Run 
debuggera. Typowo powoduje ono urucho-
mienie układu procesorowego, wykonanie 
kodu inicjacji środowiska języka C, czyli 
od adresu c_int00 i zatrzymanie wykona-
nia na początku funkcji main(). Zatrzyma-
nie jest realizowane jako pułapka progra-
mowa.

•	 Target → Run – Polecenie powoduje uru-
chomienie układu procesorowego po 
jego poprzednim zatrzymaniu. Układ 
procesorowy pracuje, aż do ponownego 
zatrzymania wykonanego automatycznie 

konanie inicjacji środowiska języka C (rys. 6). 
Licznik rozkazów (PC) jest ustawiony na 
pierwszą instrukcję funkcji main(). Pokazują to 
strzałki w oknie Disassembly oraz oknie edycyj-
nym pliku z funkcją main().

Ładowanie pliku wynikowego do 
pamięci RAM

Ładowanie kodu do pamięci RAM powo-
duje wpisanie kodu do pamięci RAM ukła-
du procesorowego poprzez jego łącze JTAG. 
W trakcie ładowania kodu typowo jest wykony-
wana weryfikacja (domyślnie włączona opcja 
Perform verification during Program Load). Za-
ładowane dane są odczytywane z pamięci i po-
równywane z oryginałem. Wystąpienie różnic 
jest sygnalizowane.

Ładowanie pliku wynikowego do 
pamięci Flash

Jeśli kod wynikowy programu ma zostać 
umieszczony w  wewnętrznej pamięci Flash 
układu procesorowego, to jest wymagane 
zaprogramowanie tej pamięci. Środowisko 
CCSv4 automatycznie rozpoznaje, które sekcje 
pliku COFF mają zostać umieszczone w  pa-
mięci Flash. Programator pamięci Flash zostaje 
uruchomiony automatycznie.

Operacja programowania pamięci Flash 
jest wykonywana w  trzech krokach: kasowa-
nie, programowanie i  weryfikowanie pamięci 
Flash. Dalej ładowanie przebiega tak samo 
jak do pamięci RAM. Postęp poszczególnych 
kroków operacji jest pokazywany w osobnym 
oknie (rys. 9). Widok tego okna może być bar-
dzo różny w zależności np. od tego, czy jest to 
pierwsze ładowanie kodu po uruchomieniu se-
sji debugowej czy następne.

Ustawienia narzędzia do programowania 
pamięci Flash można oglądać i zmieniać. Na-
leży wybrać z  menu Tools → On-Chip Flash. 
Otwierane jest okno Control Panel z zakładką 
On-Chip Flash (rysunek 10). 

Zawartość okna jest zależna od używanego 
w projekcie układu procesorowego (konfigura-
cja systemu docelowego). Można w nim zmie-
niać parametry oraz wykonywać dodatkowe 
operacje jak jednorazowe kasowanie pamięci 
Flash i programowanie hasła dostępu.

Należy uważać, aby ustawienia nie spowo-
dowały przekroczenia maksymalnej częstotli-
wości zegara systemowego SYSCLKOUT uży-
wanego układu procesorowego. 

Ładowanie symboli dla pliku 
wynikowego umieszczonego 
w pamięci nieulotnej

Jest również pewna postać ładowania 
kodu dla pamięci nielotnej typu Flash, ROM 
lub EEPROM. Jeśli pamięć Flash układu pro-
cesorowego została zaprogramowana kodem 
wynikowym programu, to CCSv4 pozwala na 
załadowanie danych symbolicznych dla de-
bugowania tego programu. Wtedy środowisko 
CCSv4 czyta dane debugowe, np. wartość sym-

w nim zawartość kodu od adresu zatrzymania 
układu procesorowego, czyli od początku kodu 
bootowania układu procesorowego z  pamięci 
Boot-ROM:
F2802x Piccolo:
0x3ff7bb: 28AD0004 MOV @SP,#0x0004
F2803x Piccolo:
0x3ff8a1: 28AD0004 MOV @SP,#0x0004

Kod załadowany do pamięci może być po-
kazywany w oknie deasemblacji na dwa sposo-
by. Tryb kodu źródłowego Source Mode – poka-
zywany jest tylko kod maszynowy po deasem-
blacji. Jest to domyślny tryb pracy.Tryb Mixed 
Mode – pokazywany jest kod źródłowy w języ-
ku C lub asemblerowym (o ile kod jest dostęp-
ny) oraz jego kod maszynowy po deasemblacji. 
W oknie deasemblacji są również pokazywane 
pułapki. Są one identyfikowane ikonkami na 
lewo od adresu instrukcji. Ich znaczenie jest 
takie samo jak w oknie edycji.

Ładowanie kodu programu
Ładowanie kodu (load) oznacza otworze-

nie wskazanego pliku formatu COFF (*.out) bę-
dącego rezultatem budowania projektu i wpisa-
nie (załadowanie) go do układu procesorowego 
docelowego. Ładowanie kodu jest dostępne 
w konfiguracji Debug, czyli po uruchomieniu 
debuggera i  po dołączeniu do systemu doce-
lowego. Zestawienie poleceń ładowania pro-
gramu/symboli jest zamieszczone w  tabeli  3. 
Ładowanie kodu wynikowego programu jest 
wykonywane automatycznie po wykonaniu 
polecenia Debug Active Project (menu Target 
→ Debug Active Project). Ładowanie kodu wy-
nikowego programu można wykonać ręcznie 
z menu Target → Load Program. Jest też polece-
nie ponownego załadowania programu Target 
→ Reload Program.

W zależności od rodzaju pamięci RAM lub 
Flash, do której ładowany jest kod, operacja 
wykonywana jest w różny sposób.

Po wydaniu polecenia Target → Load Pro-
gram otwierane jest okno wyboru pliku z ko-
dem wynikowym (rysunek 8). Przycisk Browse 
Project pozwala na automatyczne ustawienie 
ścieżki do foldera /Debug aktywnego projektu 
w polu Program file. Przycisk Browse pozwala 
na wybranie pliku z tego foldera. 

Po przyciśnięciu przycisku OK rozpoczyna 
się automatyczne ładowanie kodu do układu 
procesorowego. Postęp operacji jest pokazy-
wany w osobnym oknie (rysunek 9). Typowo, 
po wykonaniu polecenia ładowania kodu do 
pamięci program jest uruchamiany od punktu 
wejścia języka C (entry point) i  wykonywany 
do początku funkcji main(). Oznacza to wy-

Rysunek 8. Okno wyboru pliku z kodem 
wynikowym po wykonaniu polecenia 
Load Program w środowisku CCSv4
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•	 Set PC to Cursor – Polecenie dostępne po 
kliknięciu prawym klawiszem myszy na 
linię kodu w oknie edycyjnym z otwartym 
kodem źródłowym. Z podręcznego menu 
należy wybrać pozycję Set PC to Cursor. 
To samo można wykonać w oknie Disas-
sembly. Polecenie powoduje ustawienie 
licznika rozkazów układu procesorowego 
(PC) na adres kodu w miejscu, na którym 
został umieszczony kursor. Pozwala to na 
uruchomienie wykonania kodu od tego 
miejsca. Uwaga: Polecenie jest bardzo 
przydane do powtarzania wykonania ka-
wałka kodu bez konieczności ponownego 
uruchamiania układu procesorowego. 
Bardzo to ułatwia przeprowadzanie prób 
zachowania się fragmentu kodu z bieżą-
cą zawartością zmiennych. Trzeba jed-
nak pamiętać, aby nie zaburzyć struktury 
wywoływania funkcji. Czyli jest to przy-
datne raczej w ramach jednego kontekstu 
(ramki stosu) języka C.

Praca krokowa
Środowisko CCSv4 pozwala na wykony-

wanie pracy programu w sposób krokowy. Są 
dwa sposoby wykonywania pracy krokowej: 

•	 Dla kolejnych instrukcji (linii kodu źró-
dłowego) języka C.

•	 Dla kolejnych instrukcji (linii kodu ma-
szynowego) języka asemblerowego.
Praca krokowa na poziomie asemblero-

wym może być obserwowana jednocześnie 
w oknie edycyjnym pliku źródłowego języka 
C/C++ oraz, oknie deasemblacji. Na pasku 
tytułu okna deasemblacji podana jest nazwa 
pliku źródłowego, którego dotyczy kod asem-
blerowy.

Dodatkowo dla każdego z tych sposobów 
wykonywania pracy krokowej można:

•	 Wykonać pracę krokową z wchodzeniem 
do funkcji i  zatrzymanie wykonania na 
jej pierwszej instrukcji (Step Into, Assem-
bly Step Into).

•	 Wykonać wykonanie funkcji i  zatrzyma-
nie na pierwszej instrukcji po powrocie 
( Step Over, Assembly Step Over).

Rysunek 10. Okno Control Panel z zakład-
ką On-Chip Flash środowiska CCSv4 dla 
układu procesorowego TMS320F28035 
(fragment)

Rysunek 9. Okno postępu programowa-
nia pamięci Flash (faza kasowania) po 
wykonaniu polecenia Load Program dla 
projektu skonfigurowanego do pracy 
z pamięcią Flash układu procesorowego 
w środowisku CCSv4

•	 Wykonać operację wyjścia  Step Out 
powodującą wykonanie kodu bieżącej 
funkcji do końca i zatrzymanie wykona-
nia na pierwszej instrukcji po powrocie 
na wyższy poziom. 

Pułapki
Pułapki są podstawowym elementem 

każdego środowiska do debugowania kodu 
programu. Pułapka podejmuje akcję, gdy 
określone dla niej warunki zostaną spełnio-
ne. Debugger środowiska CCSv4 ma kilka 
typów pułapek. Ich dostępność zależy od 
dołączonego rodzaju układu procesorowego. 

Okna podglądu, pamięci, 
rejestrów, stosu i symboli

Wiele okien w perspektywie Debug śro-
dowiska CCSv4 włącza się automatycznie 
przy uruchomieniu sesji debuggowej, np. 
okno Debug, panel podglądu zmiennych 
z  oknami Watch i  Local(1) oraz okno edy-
cyjne z kodem funcji main(). Włączanie po-
zostałych okien jest wykonywane poprzez 
wybór pozycji z menu View. Są to: okno pa-
mięci Memory, okno rejestrów Register, okno 
przerwań Breakpoints i  okno deasemblacji 
Disassembly. 

Wizualizacja danych
Środowisko CCSv4 udostępnia możli-

wość graficznej prezentacji danych. Pod-
stawowe typy okien prezentacji graficznej 
to: Single Time, Dual Time, FFT Magnitu-
de, Complex FFT, FFT Magnitude & Pha-
se oraz FFT Waterfall. Okno wizualizacji 
można otworzyć poprzez wybór z  menu 
Tools->Graph, a  następnie wybrać okre-
ślony typ okna prezentacji. Otwierane jest 
wtedy okno dialogowe Graph Properties. 
Należy w tym oknie ustawić odpowiednie 
parametry.

Aktualne informacje dotyczące debu-
gowania w  środowisku CCSv4 znajdują się 
w pomocy (Help) tego środowiska.

Henryk A. Kowalski, EP
henryk.kowalski@ep.com.pl

po uauktywnienu się pułapki lub po wy-
konaniu polecenia Halt.

•	 Target → Halt – Polecenie powoduje zatrzy-
manie układu procesorowego. 

•	 Target → Go to Main – Polecenie typowo 
jest używane po poleceniu Reset. Powo-
duje ono uruchomienie układu proceso-
rowego i wykonanie całej funkcji inicjacji 
środowiska języka C. Układ procesorowy  
jest następnie zatrzymywany na pierwszej 
instrukcji funkcji main().

•	 Target → Run to Line – Polecenie powoduje 
uruchomienie układu procesorowego i wy-
konanie kodu aż do miejsca kodu w którym 
został umieszczony kursor.


